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Welcome

The Thermo Scientific Nicolet™ iS™5 fourier transform infrared (FT-IR) spectrometer lets 
you perform chemical analyses of sample materials by collecting data in the mid-IR spectral 
range using a variety of accessories, including transmission, attenuated total reflection (ATR), 
diffuse reflection (DRIFTS), and specular reflection (SR). The system has integrated 
verification features, a powerful software suite, and many other features that make data 
collection easy. You can install optional hardware and perform several service and 
maintenance procedures yourself. This document, or other provided documentation, contains 
the information you need.

Be sure to read the safety guide that came with the system before operating the instrument.

Conventions Used
Safety precautions and other important information use the following format:

Note  We recommend that you maintain seal and desiccation and/or purge your 
instrument at all times. Equipment damage due to failure to maintain seal and desiccation 
and/or purge is not covered by the warranty. If you have questions about this requirement, 
please contact us.

Contents

• Conventions Used

• About the Help System

• Finding Other PDF Documents

• Warranty Information

• Ordering Parts

• Contacting Us

•

Note  Notes contain helpful supplementary information.
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About the Help System
To view the electronic Help version of this document, choose Spectrometer Help Topics from 
the Help menu in OMNIC software.

Finding Other PDF Documents
PDF files of system documentation are on the documentation disk provided with your 
instrument.

Warranty Information
Thermo Fisher Scientific warrants that each product we sell you is free from defects in labor 
and materials and shall conform to its product specifications as defined in the product user 
documentation. If the product does not function as warranted during the warranty period, we 
will repair or replace it without charge. If in our judgment we are unable to do so, you may 
return it to us and we will refund your money.

This warranty replaces all other warranties, expressed or implied, including the implied 
warranties of merchantability and fitness for a particular purpose and any other obligations or 
liabilities on the part of Thermo Fisher Scientific whether in contract, warranty, negligence or 
otherwise. Thermo Fisher Scientific shall not be liable for and disclaims all consequential, 
incidental and contingent damages.

Warranty period

The system warranty period is 12 months in the U.S.A. and Canada. The warranty period 
begins on the date of installation or 30 days from the date of invoice, whichever is sooner.

The system warranty period for products sold outside the U.S.A. and Canada is 12 months 
from the date of installation or 14 months from the date of shipment, whichever is sooner.

NOTICE    Follow instructions with this label to avoid damaging the system hardware or 
losing data.

CAUTION  Indicates a hazardous situation which, if not avoided, could result in minor or 
moderate injury.

WARNING  Indicates a hazardous situation which, if not avoided, could result in death or 
serious injury.
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Limit of warranty

Misuse, accident, modification, unsuitable physical or operating environment, improper 
maintenance, or damage caused by a product for which we are not responsible will void the 
warranty. Certain components may have separate warranty periods as stated in the product 
user documentation. Consumables are not covered under warranty.

Items not covered by warranty

We do not warrant uninterrupted or error-free operation of a product. We provide certain 
non-Thermo Fisher Scientific products on an “as is” basis. Non-Thermo Fisher Scientific 
manufacturers or suppliers may provide their own warranties to you. A separate software 
warranty is provided with the software user documentation.

Ordering Parts
To order parts, contact us.

If you need to send the instrument or an accessory to us for repair, call or e-mail us first for 
any shipping requirements or other instructions.

Contacting Us
For U.S. Technical Support, please contact:

Thermo Fisher Scientific
5225 Verona Road
Madison, WI 53711-4495 U.S.A.
Telephone: 1 800 532 4752
E-mail: us.techsupport.analyze@thermofisher.com
World Wide Web: http://www.thermo.com/spectroscopy

For International Support, please contact:

Thermo Fisher Scientific
Telephone: +1 608 273 5017
E-mail: support.madison@thermofisher.com
World Wide Web: http://www.thermo.com/spectroscopy

If you have problems with your system, refer to the Troubleshooting information for help, or 
call Technical Support.
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Note  To expedite and assist in problem diagnosis, please be prepared to send us a copy of 
your diagnostics log file. The diagnostic log includes a history of important system 
parameters and events that occur during system operation. To copy the diagnostics log to 
your Windows desktop, start OMNIC software and choose File > Copy Diagnostics File 
to Desktop. Attach this file to an e-mail message to our Technical Support group.
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Operation

This section provides instructions for setting up your instrument and installing accessories.

Your instrument is designed for indoor use at altitudes up to 2,000 m (6,500 ft). It operates 
reliably at a constant temperature between 15 °C and 35 °C (60 °F and 95 °F). Temperature 
changes may result in drift in the system response.

Contents

• Electrical and Communication Cabling

• Turning the Power On and Off

• Installing an Accessory

• Collecting Data

• Setting the Purge Gas Controls

• Aligning Your Spectrometer

• Verifying the Laser Frequency

• Using the iD1 Transmission Accessory

• Entering Serial Numbers

IMPORTANT  Your instrument must be protected from excessive humidity, since the 
beamsplitters, detectors, and other components may corrode with exposure to moisture. 
Maintain humidity in the range of 20% to 80% noncondensing. To accomplish this, this 
instrument is sealed and desiccated. For additional humidity protection, the optional 
purge configuration and/or zinc selenide (ZnSe) windows can be used.

CAUTION  If a protective cover on a system component appears damaged, turn off the 
system and secure it against any unintended operation.
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Electrical and Communication Cabling
The illustration below shows the correct cable connections for electrical power and data 
communication.

Check the Preparing Your Site guide on your documentation disk for electrical and other 
system requirements before you connect the power cord. The wall outlet must be equipped 
with a 3-wire line: live, neutral, and ground.

To cable the instrument:

1. Connect the power supply to the spectrometer and to a properly grounded AC power 
source.

Power
Computer

Computer (USB) 
cable

Power cable

WARNING  To ensure a good ground connection and avoid shock hazard, do not use an 
outlet that has ground connected to a conduit ground. The ground must be a 
non-current-carrying wire connected to earth ground at the main distribution box.

WARNING  Do not block access to the power supply, AC power cord or power switch.
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2. Connect the USB cable to the spectrometer and to a USB 2.0 port on the computer. (Do 
not use a USB auxiliary port or hub.)

Related Topics

Turning the Power On and Off

Setting the Purge Gas Controls

Checking and Changing the Purge Gas Filter

Static Electricity Precautions

Turning the Power On and Off
To turn the system power on or off, press the power switch on the back of the instrument:

When the system is powered on, the blue power indicator on the main cover flashes while the 
instrument warms up and performs diagnostics (about 2 minutes) and then the indicator stays 
lit. During initialization, OMNIC software displays the number of seconds remaining and the 
Collect menu is disabled; the system cannot collect data until initialization is completed.

Power switch
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Related Topics

Electrical and Communication Cabling

Setting the Purge Gas Controls

Troubleshooting

Installing an Accessory
The Nicolet iS5 spectrometer includes the iD1 transmission accessory which accommodates a 
wide variety of samples and slide-mount sample holders for transmission experiments. 
Integrated iS5 accessories for common ATR analyses are also available. Contact us for details.

Mounting baseplates are available to accommodate a wide variety of standard accessories from 
us and other manufacturers.

All of our integrated accessories and baseplates are easy to install and remove and are 
recognized automatically by the software.

NOTICE    Do not place anything on top of the vents at the back of the instrument. 
Electronic components can overheat if these vents are blocked.

Power indicator

Contents
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These measures will help prolong the life of your instrument and will eliminate the possibility 
of spectral interference caused by volatile solvent vapors.

Using solvents that may produce HCl or HF vapors in the sample compartment may severely 
damage the system. If you use halogenated solvents, purging the instrument with dry, clean air 
or nitrogen is strongly recommended. See the Preparing Your Site guide for a details.

Installing Integrated Accessories

To install an integrated iS5 accessory, such as the iD5 ATR accessory shown below, hold it by 
the front and rear handles and lower it onto the spectrometer.

• Installing Integrated Accessories

• Installing Baseplate-mounted Accessories

• Installing Slide-mounted Accessories

WARNING  Prevent fire and explosion. The infrared source inside the instrument is an 
ignition source. If you are using volatile solvents, provide a fume hood or other active 
venting system that is free of spark and other ignition sources and prevents flammable 
vapors from collecting in the atmosphere surrounding the instrument.

CAUTION  Materials such as hydrochloric acid, hydrofluoric acid and phosgene are highly 
toxic. If you plan to regularly use solvents containing halogenated hydrocarbons, be sure 
your work area is properly ventilated.
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The accessory fits over two alignment pins on the spectrometer baseplate and is held in place 
by magnets.

If your instrument is purged, attach the purge line labeled “Accessory” to the purge inlet on 
the back of the accessory. See Installing a Purge Kit for more information.

Note  To remove an accessory, disconnect the purge line if necessary and then grasp the 
accessory by the handles and lift it up. When not using an accessory, store it in a dust-free 
environment like a cabinet or box.

Pins

Magnets

Purge inlet
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Related Topics

Using the iD1 Transmission Accessory

Installing an Accessory

Installing Baseplate-mounted Accessories

Special baseplates are available to accommodate a wide variety of accessories for FT-IR 
sampling.

iD Base Adapter

The iD Base Adapter provides a place to mount large transmission accessories and other 
specialized accessories.

Note  Avoid installing the iD Base Adapter without an attached accessory. Very strong 
magnets hold the adapter in place; you may need to use a tool to pry it free.



2 Operation
Installing an Accessory

12 Nicolet iS5 Spectrometer User Guide Thermo Scientific

For slide-mounted accessories that are too big for the iD1 Transmission Accessory, a slide 
mount that fits the iD base is available.

The iD Base Adapter has two sets of screw holes so the slide mount can be installed facing 
either direction. To install the slide mount, position it over the screw holes, and then insert 
and tighten the two washers and screws.

Use the large center screw to raise or lower a sample or accessory to align it in the infrared 
light beam.

Slide mount

Height adjustment screw
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To install an accessory attached to the iD Base Adapter, remove any accessory from the iS5 
spectrometer and place the adapter over the pins on the spectrometer baseplate. Magnets hold 
the adapter in the proper position.

Here is the iD Base Adapter and attached slide mount with a cuvette holder installed in the 
Nicolet iS5 spectrometer.
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iD Foundation Adapter

The iD Foundation Adapter fits our Foundation Series Swap-Top Modules. For information 
about these modules, see the Foundation Series User Guide on your documentation disk.

To install the adapter, remove any accessory from the iS5 spectrometer and place the adapter 
over the pins on the spectrometer baseplate. Magnets hold the adapter in the proper position. 

Tighten screws to secure
the Foundation accessory

Remove screws and panel for use 
with a diffuse reflectance accessory
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Slide any Foundation Series Swap-Top Module into the holder, rotate the accessory to line up 
the notches and pins and then hand tighten the screws (see the image above). For diffuse 
reflection accessories, remove the two screws and lower panel to accommodate the sample 
slide as shown in the image below.

Here is a Foundation Multi-bounce ATR accessory installed in the Nicolet iS5 spectrometer.

Related Topics

Installing an Accessory
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Installing Slide-mounted Accessories

The iD1 Transmission Accessory is designed to accommodate gas or liquid transmission cells 
and thin film or pellet holders that have a 2 x 3 inch slide mount.

To install a slide-mounted accessory

1. Slide the accessory into one pair of slots in the iD1 Transmission Accessory.
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Choose a pair of slots that will place the center of the accessory at the beam focus 
(designated by arrow heads on the accessory housing).

Related Topics

Installing Baseplate-mounted Accessories

Installing an Accessory

Using the iD1 Transmission Accessory

Collecting Data
For information about collecting data with your instrument, see the provided Nicolet iS5 
Getting Started and Fast Facts manuals.

Beam focus
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Setting the Purge Gas Controls
You can use an appropriate source of purge gas (dry air or nitrogen) to purge the instrument 
of moisture and other environmental contaminants. See Installing a Purge Kit for more 
information.

For best results the purge gas should be dried to a dew point of -70 °C (-94 °F) or below.

To set the purge gas controls

1. Open the main valve to start the flow of purge gas through the regulator.

2. Adjust the pressure regulator for the spectrometer until the gauge indicates that the 
pressure is 5 psig (34 ).

3. Set the flowmeter for the spectrometer to 1 scfh (0.47 l/min).

NOTICE    We recommend maintaining seal and desiccation and/or purging the 
instrument at all times. Equipment damage due to failure to maintain seal and desiccation 
and/or purge is not covered under the warranty. If you have questions about this 
requirement, please contact us.

WARNING  Never use a flammable, combustible, or toxic gas to purge this instrument. 
The purge gas must be free of oil and other reactive materials. Heat from the source or 
from laser absorption may ignite flammable gases or reactive materials in purge gas. Use 
only dried air or nitrogen to purge your instrument.

Set accessory pressure

Set accessory flow

Set spectrometer pressure

Set spectrometer flow
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4. If you are using an accessory that is purged, set the purge gas controls for the accessory as 
indicated below.

• Accessory pressure, 5 psig (34 )

• Accessory flow, 4–10 scfh (1.9–4.7 l/min)

Related Topics

Installing a Purge Kit

Checking and Changing the Purge Gas Filter

Aligning Your Spectrometer
Your instrument can be aligned automatically using OMNIC software. Alignment optimizes 
the energy throughput to the detector. Alignment can change slightly over time, particularly 
in locations that have large temperature swings or excessive vibration.

Use the Align button on the Diagnostic tab of the Experiment Setup dialog box (available 
through the Collect menu in OMNIC software). For more information, see OMNIC Help 
Topics in the Help menu.

Related Topics

Verifying the Laser Frequency

Maintaining Your Instrument

Troubleshooting

Verifying the Laser Frequency
Use the Laser Verification button on the Diagnostic tab in the Experiment Setup dialog box in 
OMNIC software to verify the laser.

For optimum system performance, verify the laser frequency according to the following 
schedule:

NOTICE    Flow rates greater than recommended values can cause vibration which can 
affect data quality.

Note  The instrument is aligned automatically each time you run a Performance 
Verification (PV) test. We recommend running a PV text at least once a month.
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To verify the laser frequency

1. From the OMNIC software main screen, choose Collect > Experiment Setup.

2. Click Laser Verification on the Diagnostic tab.

3. As prompted, remove all accessories and samples from the instrument and then click OK.

4. Click Start Verification.

When the verification is completed, one of the following occurs:

• A message indicates the laser frequency has been verified. Click OK to finish.

• The newly measured laser frequency appears below the previously measured 
frequency and a message indicates the laser frequency has been optimized. Click OK 
to finish.

Related Topics

Aligning Your Spectrometer

Maintaining Your Instrument

Troubleshooting

Spectrometer environment Spectrometer state Recommended Schedule

Stable Always powered on every 3 months

Unstable (e.g., temperature or 
humidity constantly changing)

Powered on and off 
frequently

every day or once a week

Note  The laser is verified automatically each time you run a Performance Verification 
(PV) test. We recommend running a PV text at least once a month.
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Using the iD1 Transmission Accessory
The iD1 Transmission Accessory lets you collect spectra of transmission samples, such as thin 
films, liquids in a liquid cell, and gases in a gas cell.

Install the module as explained in Installing an Accessory.

Related Topics

Installing Samples in the iD1 Transmission Accessory

Installing Integrated Accessories

Installing Slide-mounted Accessories

Collecting Data With the iD1 Transmission Accessory
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Installing Samples in the iD1 Transmission Accessory

To install a thin sample such as a film, swing open the accessory cover and slide the sample 
into any of the narrow slots. Normally a slot at or near the focus position is used. The focus 
position is at the center of the sample compartment as indicated by the arrows on the sample 
compartment housing.

The wide slot provides clearance for liquid and gas cell flanges.

Related Topics

Installing Integrated Accessories

Collecting Data With the iD1 Transmission Accessory

Collecting Data With the iD1 Transmission Accessory

For information about collecting data with the accessory, see the provided Getting Started and 
Fast Facts manuals.

Related Topics

Installing Samples in the iD1 Transmission Accessory

Beam focus

Narrow slots Wide slot
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Entering Serial Numbers
The software stores important settings, serial numbers and installation dates. Update any 
corresponding setting, serial number or installation date after replacing components in your 
spectrometer.

To check or update the instrument information

1. Choose Advanced Diagnostics in the Collect menu. The Diagnostics screen appears.

Verify that all components are working properly. (If a component malfunctions, a red 
slash mark appears over the corresponding icon on this screen. See Troubleshooting or 
contact us for assistance.)

2. Click the Installation icon. An information screen appears.

Update any pertinent information, enter today’s date and then click Save.

Related Topics

Maintaining Your Instrument

Troubleshooting
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3

Maintenance

This section provides instructions for installing and replacing hardware and maintaining your 
instrument.

Installing or Replacing Hardware

NOTICE    All other maintenance, troubleshooting or repair must be performed by one of 
our trained and certified service engineers.

WARNING  When performing any of the maintenance procedures, always follow the 
safety precautions included in the user guide or Help system and in any of the other 
documentation that came with your instrument.

Contents

• Installing or Replacing Hardware

• Maintaining Your Instrument

Contents

• Installing a Purge Kit

• Replacing Sample Compartment Windows

• Replacing the Power Supply

• Replacing the Source

WARNING  The following parts must be replaced only with replacement parts 
supplied by us:

• Infrared source
• Desiccant
• Sample compartment windows
• Power supply
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Installing a Purge Kit

Purging protects instrument components from moisture and other environmental 
contaminants by maintaining an internal atmosphere of dry air or nitrogen. If you ordered the 
purge option, you must install a purge kit.

Time needed: 30 minutes or less

Set up needed:

• Source of dry air or nitrogen that meets Thermo Scientific specifications for the 
Nicolet iS5 spectrometer. See the Preparing Your Site manual on your documentation 
disk for more information.

Tools needed:

• A 3/4-inch open-ended wrench

• An 11/16-inch open-ended wrench

• A #2 Phillips head screw driver

• Purge regulator valve (with a 1/4-inch male or 3/8-inch female fitting)

• Pipe tapes

• Purge kit with sealed desiccant packet (open just prior to installation)

To install a purge kit

1. Install the regulator valve and either a 1/4-inch male fitting or a 3/8-inch female fitting 
on the purge gas source. (Choose a valve and fittings that are appropriate for the purge gas 
source.)

NOTICE    We recommend maintaining seal and desiccation and/or purging the 
instrument at all times. Equipment damage due to failure to maintain seal and desiccation 
and/or purge is not covered under the warranty. If you have questions about this 
requirement, please contact us.

Note  For best results dry the purge gas to a dew point of -70 °C (-94 °F) or below.

Note  To order parts, call Technical Support. See Contacting Us.

WARNING  Never use a flammable, combustible, or toxic gas to purge this instrument. 
The purge gas must be free of oil and other reactive materials. Heat from the source or 
from laser absorption may ignite flammable gases or reactive materials in purge gas. Use 
only dried air or nitrogen to purge your instrument.
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2. If you used a 1/4-inch male fitting, proceed to the next step.

If you used a 3/8-inch female fitting on the purge gas source, install the 3/8-inch to 
1/4-inch reducing nipple that was included with your purge kit. Wrap the reducing 
nipple with Teflon® pipe tape before you install it, and use an 11/16-inch open-ended 
wrench to tighten the connection.

3. Wrap the reducing nipple or the 1/4-inch male fitting with Teflon pipe tape, and then 
install the pressure coupling. Use a 3/4-inch open-ended wrench to tighten the 
connection.
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4. Snap the male inlet of the wall plumbing assembly firmly into the pressure coupling.

Refer to this drawing when performing this and subsequent steps:

5. Turn off the instrument power, unplug the power cord and remove all accessories and 
samples from the system. See Turning the Power On and Off and Installing an Accessory 
for instructions.

6. Loosen the two captive Phillips head screws from the standard desiccant cartridge, and lift 
the cartridge straight up and out of the instrument.

To accessory To spectrometer

Pressure coupling

Wall plumbing assemblyFlowmeter

Pressure regulator Pressure regulator

Flowmeter

WARNING  Before opening the desiccant compartment, turn off the instrument 
power, unplug the power cord and remove all accessories and samples from the 
system. Entry of flammable liquids or gases into the desiccant compartment is an 
explosion hazard. If such entry occurs, contact us immediately and do not apply 
power to the instrument until the condition has been corrected.

Note  If the standard desiccant cartridge is stored in a dry box or sealed bag (you can 
use the bag the purge cartridge came in), the cartridge can be reused.
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7. Remove the large O-ring.

8. Open the purge kit and then open the sealed desiccant packet (must be sealed to keep the 
desiccant dry).

9. Remove the O-ring from the packet and install it on the instrument base plate (see the 
previous image). Make sure the O-ring is properly seated in the groove.

10. Remove the desiccant cartridge with purge fittings from the packet, insert the cartridge in 
the desiccant compartment, make sure it is seated properly over the O-ring and then 
secure it using the two screws.

Note the correct orientation of the cartridge (the label on the cartridge should be readable 
from the front of the instrument when the cartridge is installed).

11. Connect the right-angle flow coupler from the wall plumbing assembly (labeled “to 
spectrometer”) to the purge inlet on the instrument.

Note  Be careful not to drop the sealing O-ring into the desiccant compartment.

Purge inlet Relief valves

Purge Desiccant 
Cartridge
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12. Install any sampling accessory you removed previously.

13. If the accessory is purged, connect the straight flow coupler from the plumbing assembly 
(labeled “to accessory”) to the purge inlet on the installed accessory.

14. Open the main regulator valve and set the purge gas controls as indicated below (see 
Setting the Purge Gas Controls for details). If you are not purging an accessory, set the 
pressure regulator for accessories to zero.

15. Plug in the power cord to the instrument and turn on the power.

16. Wait 30 to 60 minutes for the instrument to fully purge.

Related Topics

Setting the Purge Gas Controls

Replacing the Desiccant

Checking and Changing the Purge Gas Filter

Replacing Sample Compartment Windows

Your instrument has windows on both sides of the sample compartment that seal the 
spectrometer from moisture and other contaminants in the room atmosphere. The windows 
must be installed, even if your system is purged.

Hardware Pressure (psig) Flow Rate (scfh)

iS5 Spectrometer 5 1

iD1 Transmission Accessory 5 4-10

iD3 ATR Accessory 5 4-10

iD5 ATR Accessory 5 4-10

iD Foundation 5 4-10

Note  If the instrument is powered off without purge, you can use either desiccant 
cartridge (with or without the purge connectors) to maintain the required humidity. 
Make sure you check the humidity indicator once a month (see Checking the 
Humidity Indicators) and replace the desiccant when necessary (see Replacing the 
Desiccant).

WARNING  Prevent fire and explosion. The infrared source inside the instrument is an 
ignition source. If you are using volatile solvents, provide a fume hood or other active 
venting system that is free of spark and other ignition sources and prevents flammable 
vapors from collecting in the atmosphere surrounding the instrument.
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The sample compartment windows are either potassium bromide (KBr) with a hygroscopic 
protective coating, or non-hygroscopic zinc selenide (ZnSe) with an anti-reflection coating 
(for extremely humid environments). Both types of windows should be clear and clean (no 
fingerprints).

Time needed: 10 minutes

Tools needed:

• iS5 window replacement tool (provided)

• iS5 replacement windows (2)

• latex gloves

To replace sample compartment windows

1. Turn off the instrument power. See Turning the Power On and Off.

NOTICE    Do not allow liquids to come into contact with the sample compartment 
windows.

NOTICE    Windows can be scratched and ruined very easily. Do not touch or attempt to 
clean them. Dust will not affect the signal, but fingerprints can degrade the performance 
of the instrument and permanently damage mirrors or windows. If you wish to remove 
dust from a mirror or window, blow it off with a gentle stream of clean, dry air or nitrogen 
(Do not use compressed air from a can or contaminants may cause damage.)

WARNING  Replace the sample compartment windows only with replacement parts 
supplied by us.

Note  If your instrument is purged, you can leave the purge on while you replace the 
windows to prevent ambient air from entering the spectrometer.

Window replacement tool

Replacement windows
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2. Remove any sampling accessory from the instrument. See Installing an Accessory.

3. Line up the three ribs in the window replacement tool with the notches in the rim of the 
installed window.

4. Press firmly on the tool and turn it counterclockwise to loosen the window.

5. Remove the tool and continue loosening the window by hand until it releases.

6. Gently insert the new window into the opening and turn it clockwise until hand tight.

The window should screw in easily at the start; if it doesn’t, remove the window and 
restart to avoid stripping the threads.

7. Using the window replacement tool, slowly and firmly turn the window as far as it will go 
(you will feel the O-ring compress fully when the window rim contacts the housing).

8. Turn on the instrument power and start OMNIC software.

9. Make sure the window type is properly configured in OMNIC software.

Choose Advanced Diagnostics in the Collect menu. The Diagnostics screen is displayed.

Note  The window fittings are tight. Use one hand to stabilize the instrument and the 
other to remove the window.

Note  Be sure to use gloves to handle replacement windows and handle them by the 
rims. (Avoid touching the windows even when wearing gloves.)

Sample 
compartment window
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Click the Installation icon. A diagnostic information screen appears.

Select the Purge Window type (KBr or ZnSe), enter today’s date and then click Save.

10. Make sure the system has been on for at least 15 minutes (one to six hours for best 
results), and then run the Performance Verification (PV) test.

From the OMNIC main screen, choose View > System Status. The System Status 
Overview dialog box is displayed.
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Click Performance Verification and then click Run.

11. Replace any accessories you removed earlier on the instrument.

Related Topics

Troubleshooting

Replacing the Power Supply

Time needed: 5 minutes or less

Tools needed: None

To replace the power supply

1. Turn off the instrument power. See Turning the Power On and Off.

Note  To order parts, call our Technical Support. See Contacting Us.

CAUTION  To avoid a shock hazard, do not:
• Attempt to remove the cover of the power supply.
• Allow liquid to run into the power supply or the back of the instrument.
• Block access to the power supply, AC power cord or power switch.

WARNING  Before replacing the power supply, turn off the instrument. Replace the power 
supply only with replacement parts supplied by us.



 3 Maintenance
Installing or Replacing Hardware

Thermo Scientific Nicolet iS5 Spectrometer User Guide 35

2. Disconnect the old power supply from the wall outlet or power strip and from the 
instrument power connector.

3. Disconnect the AC power cord from the power supply.

4. Connect your AC power cord to the new power supply.

5. Connect the power supply first to the instrument power connector and then to the wall 
outlet or power strip. The wall outlet you use must be equipped with a 3-wire line: live, 
neutral, and ground.

6. Turn on the instrument power.

Note  The power supply replacement kit does not include the AC power cord, which 
is specific for the location of your installed instrument. Save the cord and use it with 
the new power supply. If the power cord becomes damaged, call our Technical 
Support to order a new one. See Contacting Us.

Power switch

Power supply

Power 
connector

AC power cordDC power cord

WARNING  To ensure a good ground connection and avoid shock hazard, do not use an 
outlet that is connected to a conduit ground. The ground must be a noncurrent-carrying 
wire connected to earth ground at the main distribution box.
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The blue power indicator on the main cover flashes while the instrument warms up and 
performs diagnostics (about 2 minutes) and then the indicator stays lit. If the instrument 
does not function normally, turn off the power and check the cable connections between 
the power supply, the instrument, and the wall outlet or power strip. If the connectors are 
seated properly and the instrument still does not function normally, contact Technical 
Support for assistance; see Contacting Us.

7. Enter the serial number for the new power supply in OMNIC software.

Choose Advanced Diagnostics in the Collect menu. The Diagnostics screen is displayed.

Click the Installation icon. A diagnostic information screen appears.

Type the serial number for the new power supply, enter today’s date and then click Save.

8. Make sure the system has been on for at least 15 minutes (one to six hours for best 
results), and then run the Performance Verification (PV) test. 

From the OMNIC main screen, choose View > System Status. The System Status 
Overview dialog box is displayed.
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Click Performance Verification and then click Run.

Related Topics

Troubleshooting

Replacing the Source

Time needed: 25 minutes or less

Tools needed:

• A #1 Phillips head screwdriver (provided with the instrument)

Note  To order parts, contact Technical Support; see Contacting Us.

WARNING  Before replacing the source, turn off the instrument. Replace the source only 
with replacement parts supplied by us.

WARNING  The source becomes extremely hot while you are using the instrument. 
Always allow the source to cool for at least 10 minutes after it is turned off before you 
work with it.
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To replace or change the source

1. Turn off the instrument (see Turning the Power On and Off) and unplug its power cord.

2. Disconnect the cables from the back of the instrument.

3. If the spectrometer or an installed accessory is purged, disconnect the purge lines from the 
spectrometer and the accessory (quick connect fittings stop the flow automatically). See 
Installing a Purge Kit for more information.

4. Remove any installed accessories from the instrument (see Installing an Accessory).

5. Carefully tip the instrument back until it rests on the four feet on the rear panel.

NOTICE    Never touch a source element with your bare fingers. Skin oils or other deposits 
on the element will shorten its life. Always use clean finger cots, gloves, or clean laboratory 
tissue when handling a source element.

Note  Make sure at least 10 minutes have passed since you turned off the instrument 
before you perform the next step.
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6. Use a #1 Phillips head screwdriver to loosen the three captive screws that hold the source 
in place.

7. Grasp the bale firmly and pull the source straight out of the instrument.

8. Record the serial number for the new source on a piece of paper. You will need to enter it 
after the source is installed.

9. Insert the new source.

Make sure the three captive screws are straight and then slowly insert the source into the 
cavity until the source mount is flush with the instrument. Tighten the screws to secure 
the source and snap the bale into its storage position.

10. Carefully return the instrument to its upright position and reconnect the cables you 
removed.

11. If your instrument is not purged, replace the desiccant. See Replacing the Desiccant for 
instructions.

WARNING  To ensure a good ground connection and avoid shock hazard, do not use an 
outlet that is connected to a conduit ground. The ground must be a noncurrent-carrying 
wire connected to earth ground at the main distribution box.
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12. Plug in the power cord to the instrument, turn on the power switch and start OMNIC 
software.

13. Wait until the power indicator stops flashing.

14. Enter the serial number for the new source in OMNIC software.

Choose Advanced Diagnostics in the Collect menu. The Diagnostics screen appears.

Verify that the new source is working properly. (If it does not work properly, a red slash 
mark appears over the Source icon on this screen. Contact Technical Support for 
assistance; see Contacting Us.)

Click the Installation icon. A diagnostic information screen appears.

Type the serial number for the new source (recorded in step 8), enter today’s date and 
then click Save.

15. Make sure the system has been on for at least 15 minutes (one to six hours for best 
results), and then align the instrument (see Aligning Your Spectrometer).



 3 Maintenance
Maintaining Your Instrument

Thermo Scientific Nicolet iS5 Spectrometer User Guide 41

16. Run the Performance Verification (PV) test.

From the OMNIC main screen, choose View > System Status. The System Status 
Overview dialog box is displayed.

Click Performance Verification and then click Run.

17. Replace any accessories you removed earlier.

18. If the system is purged, reconnect the purge lines.

Related Topics

Troubleshooting

Maintaining Your Instrument
Contents
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Cleaning Your Instrument

If the outside of the instrument needs cleaning, turn it off (see Turning the Power On and 
Off) and disconnect the power supply. Then use a soft cloth that is damp (not wet) and a mild 
soap to clean the outside of the instrument.

Related Topics

Static Electricity Precautions

Cleaning the iD1 Transmission Accessory

If the outside of the accessory needs to be cleaned, remove the accessory from the instrument, 
and use a soft, damp (not wet) cloth and a mild soap to clean it. Do not use harsh detergents, 
solvents, chemicals or abrasives (since they can damage the finish), and do not allow liquid to 
contact any windows (such as those in the sample compartment). When you are finished 
cleaning the accessory, allow it to dry, and then reinstall it in the instrument.

• Cleaning Your Instrument

• Static Electricity Precautions

• Checking the Humidity Indicators

• Replacing the Desiccant

• Regenerating the Desiccant

• Checking and Changing the Purge Gas Filter

CAUTION  To avoid a shock hazard, do not allow liquid to run into the power supply or 
the back of the instrument.

NOTICE    Do not use harsh detergents, solvents, chemicals or abrasives; these can damage 
the finish. Do not allow liquid to contact any windows in the sample compartment.

NOTICE    Windows can be scratched and ruined very easily. Do not touch or attempt to 
clean them. Dust will not affect the signal, but fingerprints can degrade the performance 
of the instrument and permanently damage mirrors or windows. If you wish to remove 
dust from a mirror or window, blow it off with a gentle stream of clean, dry air or 
nitrogen. Never allow any liquid to come into contact with a window or optical 
component in the instrument.
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Static Electricity Precautions

Critical components in the instrument can be permanently damaged by static electricity. To 
help prevent such damage, follow these recommendations:

Related Topics

Electrical and Communication Cabling

Troubleshooting

Checking the Humidity Indicators

The instrument is tightly sealed and its optical components are protected by desiccant that 
absorbs water vapor. The instrument can also be purged with dry air or nitrogen (see 
Installing a Purge Kit).

Follow these steps to monitor the humidity level inside the instrument.

Related Topics

Replacing the Desiccant

Regenerating the Desiccant

Installing a Purge Kit

Troubleshooting

NOTICE    Before you disconnect the power supply, always discharge any static electricity 
you may have accumulated by touching the perforated metal shield over the power supply.

NOTICE    Do not touch any printed circuit board in the instrument (such as the circuit 
board on the detector).

NOTICE    Do not remove replacement components from their protective packaging until 
you are ready to install that component in the instrument.

NOTICE    We recommend maintaining seal and desiccation and/or purging the 
instrument at all times. Equipment damage due to failure to maintain seal and desiccation 
and/or purge is not covered under the warranty. If you have questions about this 
requirement, call Technical Support; see Contacting Us.

Contents

• Checking Humidity When the Instrument is Powered Off

• Checking Humidity When the Instrument is Powered On
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Checking Humidity When the Instrument is Powered Off

A paper indicator lets you know when to change the desiccant when the instrument is 
powered off. 

As long as the humidity indicator on the instrument is blue, the desiccant is not saturated and 
does not need replacement. When the desiccant becomes saturated, the humidity indicator 
turns pink and then light pink or almost white. This means you must replace the desiccant 
and the humidity indicator. See Replacing the Desiccant for instructions.

Related Topics

Checking the Humidity Indicators

Checking Humidity When the Instrument is Powered On

When the instrument is powered on, an internal sensor closely monitors the humidity level 
inside the instrument and alerts you when the humidity is high.

To check the internal humidity indicator

1. From the OMNIC software main screen, choose Advanced Diagnostics in the Collect 
menu. The Diagnostics screen appears.

NOTICE    Check the paper humidity indicator at least once a month when the instrument 
is powered off.

Humidity indicator
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2. Click the Electronics icon. An information screen appears.

3. Verify that the current Internal Humidity value is between 2 and 50%.

Related Topics

Checking the Humidity Indicators

Replacing the Desiccant

If your instrument is not equipped with a purge kit, or the purge is off, you must monitor the 
humidity level inside the spectrometer. Replace the desiccant when the paper humidity 
indicator turns pink (can be light pink or almost white) or the software displays a message that 
the internal humidity is above 50%. Replace the paper humidity indicator each time you 
replace the desiccant.

Time needed: 5 minutes or less

Tools needed:

Note  When the internal humidity is above 50%, OMNIC software displays a 
message to replace the desiccant (see Replacing the Desiccant) or increase the purge 
flow (see Setting the Purge Gas Controls). If the humidity is above a critical level, the 
System Status will report an instrument failure.
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• Desiccant replacement kit (or desiccant canisters that have been regenerated)

• A #1 Phillips head screw driver

• A #2 Phillips head screw driver

• Gloves, finger cots, or laboratory tissue (to handle the humidity indicator)

To replace the desiccant

1. Turn off the instrument (see Turning the Power On and Off) and unplug the power cord.

2. Remove any installed accessory and all samples from the instrument (see Installing an 
Accessory).

3. Use the #2 Phillips head screw driver to loosen the two captive screws from the desiccant 
cartridge, and lift the cartridge straight up and out of the instrument.

Note  To order parts, contact Technical Support; see Contacting Us.

WARNING  Before opening the desiccant compartment, turn off the instrument power, 
unplug the power cord and remove all accessories and samples from the system. Entry of 
flammable liquids or gases into the desiccant compartment is an explosion hazard. If such 
entry occurs, contact us immediately and do not apply power to the instrument until the 
condition has been corrected.

NOTICE    Make sure nothing falls into the instrument while the desiccant cover is 
removed.

WARNING  Replace the desiccant only with replacement parts supplied by us.

Note  You can use either desiccant cartridge (with or without the purge connector) to 
maintain the required humidity when the instrument is powered off. The illustrations 
below show the nonpurged version of the desiccant cartridge. To see the purged 
version, see Installing a Purge Kit. The instructions for replacing the desiccant 
canisters are the same for both cartridges.
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4. Remove the large O-ring.

5. Use the #1 Phillips head screw driver to remove the eight screws that hold the two 
saturated desiccant canisters to the desiccant cartridge.

Note  Be careful not to drop the sealing O-ring into the desiccant compartment.

Remove these screws 
(4 on each side)

Humidity indicator

Desiccant cartridge

Desiccant canisters

Channel
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6. Turn the desiccant cartridge upside down and peel the old humidity indicator off the 
window.

7. Open the sealed packet that contains the new desiccant (must be sealed to maintain the 
desiccant) and remove the new humidity indicator.

8. Turn the desiccant cartridge upside down and press the blue indicator onto the window 
so that the flat edges of the indicator are aligned with the edges of the cartridge. The text 
should be visible through the window when you turn the cartridge right side up.

9. Install the new desiccant canisters. See the previous illustration for this step.

Insert each canister into the channel of the desiccant cartridge. Line up the screw hole in 
the cartridge with the corresponding hole in the canister and then insert and gently 
tighten each screw, first on one side of the cartridge and then the other, until all the screws 
are finger tight. Be careful not to overtighten the screws.

Repeat for the other canister.

10. Insert the desiccant cartridge into the spectrometer so that the text on the humidity 
indicator can be read by someone standing in front of the instrument.

Make sure the cartridge is seated properly over the O-ring and then secure it using the 
two screws.

11. Plug in the power cord to the instrument and turn on the power.

12. Make sure the system has been on for at least 15 minutes (one to six hours for best 
results), and then run the Performance Verification (PV) test.

From the OMNIC main screen, choose View > System Status. The System Status 
Overview dialog box is displayed.

WARNING  The contents of the desiccant canisters (hydrated metal aluminosilicate 
molecular sieve) could be harmful if ingested. If you discard the saturated desiccant 
canisters, make sure they are properly disposed of. 

NOTICE    Always wear lab gloves or finger cots, or use laboratory tissue, when 
handling a new humidity indicator. Oil or moisture from skin can discolor the 
indicator.

NOTICE    Make sure that the indicator is pressed tightly against the window so that it 
does not come loose in the desiccant compartment when you reinstall the cartridge.

WARNING  To ensure a good ground connection and avoid shock hazard, do not use an 
outlet that is connected to a conduit ground. The ground must be a noncurrent-carrying 
wire connected to earth ground at the main distribution box.
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Click Performance Verification and then click Run.

13. Replace any accessories you removed earlier.

Related Topics

Checking the Humidity Indicators

Regenerating the Desiccant

Installing a Purge Kit

Regenerating the Desiccant

When the desiccant canisters must be replaced, you can contact us to order new desiccant 
canisters (see Contacting Us), or you can dry and reuse the saturated canisters according to the 
following instructions.

Time needed: 3 hours

Tools needed:

• Vented oven

• Insulated cloth or hot pad
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To regenerate the desiccant

1. Place the saturated desiccant canisters in a vented oven at 150 °C (about 300 °F) for three 
hours.

2. Use an insulated cloth or hot pad to remove the desiccant canisters from the oven.

Allow the canisters to cool on the hot pad or cloth, and do not attempt to handle or 
install them until they have cooled to room temperature. As soon as the canisters reach 
room temperature, however, you must either install them in the instrument or seal them 
in an airtight container or bag. Otherwise, they will absorb moisture from the air in the 
room and quickly become saturated again.

Related Topics

Checking the Humidity Indicators

Replacing the Desiccant

Installing a Purge Kit

Checking and Changing the Purge Gas Filter

Check the purge filter occasionally to make sure it is clean and dry. (The illustration below 
shows where the purge filter is located.)

Note  If you need to replace the humidity indicator, you must order new desiccant 
canisters. A new humidity indicator is included with the new desiccant canisters.

NOTICE    If you are going to dry and reuse saturated desiccant canisters, make sure you 
have fresh desiccant canisters you can place in the instrument while the saturated canisters 
dry.

NOTICE    Do not leave canisters in the oven for more than three hours and do not exceed 
a temperature of 150 °C (about 300 °F).

NOTICE    Make sure the insulated cloth or hot pad you use to handle the regenerated 
desiccant canisters is not contaminated with substances that could be absorbed by the 
desiccant and subsequently released into the instrument.

WARNING  To avoid a burn hazard, use an insulated cloth or hot pad to handle the heated 
desiccant canisters, and always wait until the canisters have cooled to room temperature 
before reinstalling them in the instrument.
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If the filter is clean and white, it does not need replacement. If the filter is yellow, or otherwise 
discolored, or if it is contaminated with debris or foreign particles, replace the filter.

Time needed: 5 minutes or less

Tools needed: None

To change the purge gas filter

1. Turn off the purge gas at the main valve. Do not turn down the flowmeter or the pressure 
regulator.

2. Remove the plastic bowl that houses the filter and then remove the filter. (You can 
unscrew them both by hand.)

NOTICE    We recommend maintaining seal and desiccation and/or purging the 
instrument at all times. Equipment damage due to failure to maintain seal and desiccation 
and/or purge is not covered under the warranty. If you have questions about this 
requirement, please contact us.

Note  To order parts, contact Technical Support; see Contacting Us.
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3. Install the new filter and then reinstall the bowl.

4. Open the main valve to turn on the purge flow to the instrument.

Related Topics

Installing a Purge Kit

Setting the Purge Gas Controls

Replacing the Laser

The laser in your instrument is not user-replaceable. If you suspect there is a problem with the 
laser, contact Technical Support for assistance; see Contacting Us.

Related Topics

Troubleshooting

Replacing the Detector

The detector in your instrument is not user-replaceable. If you suspect there is a problem with 
the detector, contact Technical Support for assistance; see Contacting Us.

Related Topics

Troubleshooting

Note  You may notice increased levels of water and carbon dioxide in spectra collected 
immediately after you have had the purge gas turned off. If this interferes with your 
data, wait 15 to 60 minutes until purge is completely re-established.

Bowl
Filter
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Replacing the Electronics Module

The electronics module in your instrument is not user-replaceable. If you suspect there is a 
problem with the electronics module, contact Technical Support for assistance; see 
Contacting Us.

Related Topics

Troubleshooting

Replacing Fuses

The fuses in your instrument are in the power supply and are not user-replaceable. If the fuses 
blow, you must replace the power supply (see Replacing the Power Supply). If you need 
assistance, contact Technical Support; see Contacting Us.

Related Topics

Replacing the Power Supply

Troubleshooting
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4

Troubleshooting

Using the Troubleshooting Topics
The troubleshooting topics will help you solve problems with the instrument. These topics are 
divided as follows:

Hardware Problems contains topics that address specific hardware problems you may 
encounter. Each topic lists steps you can take to try to resolve the problem.

Error Messages contains topics that deal with error messages you may see. Each topic lists 
steps you can take if you see such error messages.

To expedite and assist in problem diagnosis, please be prepared to send us a copy of your 
diagnostics log file. The diagnostic log includes a history of important system parameters and 
events that occur during system operation. To copy the diagnostics log to your Windows 
desktop, start OMNIC software and choose File > Copy Diagnostics File to Desktop. 
Attach this file to an e-mail message to our Technical Support group. See Contacting Us for 
our e-mail addresses.

Contents

• Using the Troubleshooting Topics

• Hardware Problems

• Error Messages

Note  If you are having a problem with applications or software, refer to the electronic or 
printed software documentation that came with your system.

WARNING  When performing any of the procedures in the troubleshooting topics, always 
follow the safety precautions included in this document or Help system and in any of the 
other documentation that came with your instrument.
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Hardware Problems

Spectral Peaks Appear Shifted in Wavenumber Axis

1. Peak position, band shape and intensity can all be affected by special sampling techniques 
such as ATR or specular reflection. To determine if this is the problem, remove your 
accessory and collect a known sample in transmission. Compare the peak positions in the 
transmission spectrum with the peak positions in the ATR or other spectrum.

2. Run laser verification. See Verifying the Laser Frequency.

3. Contact Technical Support for assistance; see Contacting Us.

Fails Laser Frequency Verification

1. Laser verification requires some water vapor to be present in the sample compartment. If 
laser verification fails, remove any accessory from the spectrometer, breath slowly into the 
sample compartment and immediately rerun laser verification.

2. If laser verification fails again, contact Technical Support for assistance; see Contacting 
Us.

The Power Indicator Does Not Light When You Turn on Your Instrument

1. Turn the instrument off and check the connections between the instrument and the 
power supply.

2. Make sure the power cord is securely connected to the power supply and the power 
supply is connected to a properly grounded and working outlet.

Contents

• Spectral Peaks Appear Shifted in Wavenumber Axis

• Fails Laser Frequency Verification

• The Power Indicator Does Not Light When You Turn on Your Instrument

• The Power Indicator Blinks Continuously

• The System Scans Normally but the Signal Intensity Is Low

• The Spectra Have Noise Spikes

• The Baseline Is Not Stable

• The Alignment Fails

• Data Cannot Be Collected (or Other Software Problems)
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3. Check the power cord descriptions and part numbers to make sure the power cord is 
appropriate for your local AC power source. Order a new power cord if necessary.

4. Check the ground prong on the power cord. If the ground prong has been removed or is 
defective, replace the power cord.

5. Contact Technical Support for assistance; see Contacting Us.

The Power Indicator Blinks Continuously

1. The iS5 power indicator blinks for two minutes after power up while the instrument runs 
internal diagnostic tests. If the power indicator continues to blink after two minutes, 
there is a problem with the internal temperature or humidity.

2. Open Experiment Setup and click the Diagnostic tab. Click the status icon that has a red 
slash for details.

3. If the internal humidity is too high, see The Humidity Is Too High.

4. If the internal temperature is out of specification, see The Instrument Temperature Is Out 
of Specification.

5. Contact Technical Support for assistance; see Contacting Us.

The System Scans Normally but the Signal Intensity Is Low

1. Make sure nothing is blocking the light beam.

2. Make sure any accessories you are using are installed and aligned correctly. (For more 
information, see the instructions that came with the accessory.)

3. Open Experiment Setup, click the Bench tab and make sure the DTGS detector is 
selected.

4. Click the Diagnostic tab in Experiment Setup, and then click Align.

5. If the signal is still low, select View Reference Detector on the Diagnostic tab. If the 
interferogram appears, you may have a problem with the IR detector. Contact Technical 
Support for assistance.

6. Open Experiment Setup, click the Diagnostic tab, click the Source icon and check that 
the source current and voltage are within specifications.

7. Remove any accessories from the instrument and check KBr sample compartment 
windows for damage due to condensation (the surface will be cloudy). Contact Technical 
Support for assistance if they are not clear or appear to be damaged.

8. Check the sample compartment windows for contaminants.

a. Collect a transmission background and sample spectrum without an accessory in the 
sample compartment. 
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b. Remove the sample compartment windows (see Replacing Sample Compartment 
Windows). 

c. Collect a background and sample spectrum.

d. Compare the two sample spectra. If there are significant differences between the 
spectra, the sample compartment windows may be contaminated. Replace the 
windows.

9. Compare the single beam spectrum you just collected to an archived single beam 
spectrum from this instrument.

If the overall amplitude is low, you may need to replace the source (see Replacing the 
Source). 

If the shape of the spectrum is distorted, align the spectrometer (click Align on the 
Diagnostic tab in Experiment Setup). 

If the spectrum has strong artifacts or peaks, the spectrometer’s internal optics may be 
contaminated. Contact Technical Support for assistance.

10. Contact Technical Support for assistance; see Contacting Us.

The Spectra Have Noise Spikes

1. It is normal for sample spectra to be noisy in the high and low wavenumber regions 
compared to the region around 2000 cm-1. This is because the black body energy of the 
source drops off dramatically below 1000 cm-1 and decreases slowly above 3000 cm-1. To 
improve the ratio of signal to noise, increase the number of scans.

2. If noise spikes are apparent below 1000 cm-1, you may have a disturbance due to external 
vibration or acoustic noise. Move the instrument to a location that is free of vibration 
and/or acoustic noise.

3. If sharp spikes are apparent throughout the spectra, you may have problems from 
electrical noise.

a. Remove any potential sources of electrical noise emission such as computers or other 
lab equipment.

b. Your power supply or USB cable may be picking up electrical noise from other 
equipment or cables. Reposition the power supply or USB cable.

c. Your AC power source may contain electrical noise. See the Preparing Your Site guide 
on your documentation disk for electrical specifications. You may need an AC power 
conditioner.

d. Your power supply may be failing. Replace the power supply.

e. Contact Technical Support for assistance; see Contacting Us.
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The Baseline Is Not Stable

1. Minimize the acoustic noise inside the instrument. If the instrument has the purge 
option, lower the purge flow rate until the baseline is stable.

2. Open Experiment Setup, click the Diagnostic tab, and then click Align.

3. Make sure the environmental conditions (especially vibration) meet the requirements 
listed in the Preparing Your Site guide on your documentation disk.

4. Make sure the ambient temperature is not changing dramatically.

5. Check the humidity indicator and replace the desiccant and indicator if needed.

6. Make sure the ambient humidity is not changing dramatically. If it is, consider adding the 
purge option (see Installing a Purge Kit).

7. If the power to the instrument was recently turned on, allow 1 to 6 hours for the 
temperature to completely stabilize.

8. Open Experiment Setup and click the Bench tab. Click the Laser icon and check the laser 
indicators. If a laser measurement is out of tolerance, contact Technical Support for 
assistance.

9. Contact Technical Support for assistance; see Contacting Us.

The Alignment Fails

1. Make sure the instrument is scanning. (Open Experiment Setup, click the Diagnostic tab 
and check that an interferogram appears in the window.) If no interferogram appears, 
click Reset Bench, and then click Align. If the interferogram reappears, check that the 
Max readout for the interferogram peak is at least 0.1 Volts.

2. If no interferogram appears after alignment, select View Reference Detector on the 
Diagnostic tab. If the interferogram appears, you may have a problem with the IR 
detector.

3. Check the sample compartment windows for damage. Contact Technical Support for 
assistance if they are not clear or appear to be damaged.

4. Open Experiment Setup and click the Diagnostic tab. If one of the status indicators has a 
red slash through it, click the indicator and follow the on-line instructions to resolve the 
problem.

5. Open Experiment Setup, click the Diagnostic tab, and then click Reset Bench.

Note  If you are using purge and the accessory cover was recently opened (or a service 
representative opened the main cover), allow the instrument to equilibrate for 1 to 6 hours 
after the cover is closed.
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6. Make sure the system has been on for at least 15 minutes (one hour for best results), and 
then click Align on the Diagnostic tab.

7. Make sure any accessories are installed according to the instructions that came with them.

8. Contact Technical Support for assistance; see Contacting Us.

Data Cannot Be Collected (or Other Software Problems)

1. Make sure the system has completed the initialization period (about 2 minutes after you 
power it up). During initialization, the blue power indicator on the front of the 
instrument flashes and the OMNIC Collect menu is disabled.

2. Open Experiment Setup, click the Diagnostic tab, and then click Reset Bench.

3. Close OMNIC software. Turn off the instrument power. Wait a few seconds and then 
turn on the instrument power. Restart OMNIC software.

4. Shut down the computer and turn off the instrument power. Check the data cable. If it is 
damaged, replace it. If the cable is loose or disconnected, reconnect it. Turn the on the 
instrument power. Then turn on the computer and restart OMNIC software.

5. Contact Technical Support for assistance; see Contacting Us.

Error Messages

The Computer Cannot Communicate With the Instrument

Check that the computer USB port supports USB version 2.0 and the cable between the 
computer and the spectrometer is a high speed USB cable. See “Computer Requirements for 
FT-IR and FT-Raman Systems” on your documentation disk for details.

6. Open Experiment Setup, click the Diagnostic tab, and then click Reset Bench.

Contents

• The Computer Cannot Communicate With the Instrument

• The Instrument Temperature Is Out of Specification

• OMNIC Cannot Communicate With the Detector

• The Instrument Is Not Scanning

• The Laser Voltage Is Out of Specification

• The Source Voltage Is Out of Specification

• The Power Supply Voltages Are Out of Tolerance
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7. If the problem continues, close OMNIC software and turn off the instrument power. 
Wait for a few seconds, and then turn on the instrument power. Restart OMNIC 
software.

8. If the Power indicator on the instrument does not light, make sure the power supply is 
connected to the instrument and a properly grounded wall outlet or power strip.

9. Turn off the computer and then turn off the instrument power. Check the USB data 
cable. If the cable is damaged, replace it. If the cable is loose or disconnected, reconnect it.

10. Turn on the instrument power. Turn on the computer and restart OMNIC software.

11. Remove any USB computer accessories that may be interfering with communication with 
the spectrometer.

12. Close any applications that might interfere with OMNIC software.

13. Contact Technical Support for assistance; see Contacting Us.

The Instrument Temperature Is Out of Specification

1. Make sure nothing is placed on top of the instrument and air can flow freely around it.

2. The ambient temperature may be too high. The ambient temperature should be between 
18 °C and 35 °C (64 °F and 95 °F). Allow 1 to 6 hours for the spectrometer to come to 
temperature equilibrium.

3. Contact Technical Support for assistance; see Contacting Us.

OMNIC Cannot Communicate With the Detector

If OMNIC software cannot communicate with the detector, contact Technical Support for 
assistance; see Contacting Us.

The Instrument Is Not Scanning

1. Turn on the instrument power (if it is not already on).

2. Start OMNIC software.

3. Make sure the system has been on for at least 15 minutes (one hour for best results), and 
then align the instrument (open Experiment Setup, click the Diagnostic tab, and then 
click Align). If the instrument does not resume scanning, proceed to the next step.

Note  After 1 hour without data collection activity, the interferometer automatically stops 
scanning. Any subsequent data collection activity will cause the interferometer to begin 
scanning again.
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4. Turn off the power to the computer and the instrument. Leave the power off for 
15 seconds. Turn on the instrument power. Turn on the computer and restart OMNIC 
software. If the instrument does not resume scanning, proceed to the next step.

5. Select View Reference Detector on the Diagnostic tab.

If the instrument scans normally (an interferogram should appear in the window in the 
Experiment Setup dialog box), the problem is probably related to the sample or the 
detector. Make sure that the sample compartment beam is not blocked, and check the 
Diagnostic tab of the Experiment Setup dialog box to make sure the detector is 
recognized. If it is not, contact Technical Support for assistance; see Contacting Us.

6. Check all of the status indicators on the Diagnostic tab of the Experiment Setup dialog 
box. Click any indicator that has a red slash through it to view diagnostic information 
about the component.

If the laser frequency is outside the specified range, contact Technical Support to have the 
electronics module replaced. If the laser voltage or current is outside the specified range, 
contact Technical Support for assistance.

If the temperature is not in the acceptable range, make sure the cooling vents on the back 
of the instrument are not blocked and nothing is stacked on top of the instrument. 
Maintain at least 30 cm (12 in) of clearance behind the instrument and 64 cm (25 in) of 
clearance above the table. Make sure the ambient temperature is between 18 °C and 
35 °C (64 °F and 95°F).

7. Contact Technical Support for assistance; see Contacting Us.

The Laser Voltage Is Out of Specification

1. Remove any accessories or samples from the sample compartment.

2. Open Experiment Setup, click the Diagnostic tab, and then click Align.

3. Contact Technical Support for assistance; see Contacting Us.

The Source Voltage Is Out of Specification

1. Make sure the source is properly seated in its holder, and the source holder is properly 
seated in the instrument.

2. Replace the source. See Replacing the Source.

3. Contact Technical Support for assistance; see Contacting Us.

The Power Supply Voltages Are Out of Tolerance

1. Open Experiment Setup, click the Diagnostic tab, and then click the Power icon. Check 
that the current value for +12 Volt is within specifications. If it is out of the specified 
range, replace the power supply.
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2. If other values on the Power diagnostic screen are out of their specified ranges, contact 
Technical Support for assistance; see Contacting Us.

The Humidity Is Too High

1. If the instrument is equipped with an optional purge kit, check that the purge gas flow is 
set properly; see Setting the Purge Gas Controls for details.

2. Check the humidity indicator and replace the desiccant and indicator; see Replacing the 
Desiccant for instructions. 

The Laser Temperature Is Out of Specification

1. Make sure the room temperature is between 18 °C and 35 °C (64 °F and 95 °F), and 
allow the instrument adequate time to stabilize.

2. Contact Technical Support for assistance; see Contacting Us.

The Interferometer Temperature Is Out of Specification

1. Make sure the room temperature is between 18 °C and 35 °C (64 °F and 95 °F), and 
allow the instrument adequate time to stabilize.

2. Contact Technical Support for assistance; see Contacting Us.

The Laser Frequency Is Out of Specification

1. Open Experiment Setup, click the Diagnostic tab, and then click Align.

2. Click Laser Verification on the Diagnostic tab.

3. Contact Technical Support for assistance; see Contacting Us.
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